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E A LAEBIBWeb GUISEIBCLIE RGUIZ.

fEFAWeb GUIJ5 3%

1 - 4.8 E|Administration > Admin Access > Administrators > Admin Users,
5REERAE

6.8 — T .

‘diik: Identity Services Engine Administration / System

B Bookmarks Deployment Licensing Certificates Logging Maintenance Upgrade Health Chacks Backup & Restora 2 Admin Access Settings

8% Dashboard Athariticarion

Administrators

11 Context Visibility FrT e,

o~ Sabec A [
A\ Operations 3 Adminiatrators | 6
e - & Edn L

& |, e e O

= " Adeaiin Grovps Status Nameo Description First Name  Last Mame Email Address Admin Groups

| 1] Administration | |

! J | 5 B @Enabled & admin Dofault Admin User Super Admin

A Work Centars Settings e )

71 Interactive Featuras

7 A E SRR,

8.1 A Current PasswordfINew Password.



= bl |dentity Services

i Palicy

L]

Administration

Work Centers

ERACLIAE

Engine Administration / System

Deployment L g Certificat Logging Maintenance Upgrade Health Checks Backup & Restore Admin Access Settings
Authantication
~ Admin User
nnnnnnnnn on .
Narne admin
nnnnnnnnnnnn
Ao Usae 3 B9 Cobied v
i £
| Inclede system alarms in emall
sttings

* New Password

~ User Information

First Nama

Last Namo

TECLIFR | #{Treset-#application ise <username>

SRR R B AT ER,

:isé331/admin#application reset—passwd

ise admin

Enter new password:

WMANEEHBRRR  BREEASHEE,

ise331/admin#application reset—-passwd ise

Enter new

admin
password:

Confirm new password:

Password reset successfully.

CLIBRWEERR
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1TRARE, MRERBCLIBBFTHE , ALEHTERREBE,

ECLIL | BfTdhS#password » RSB REBWAENZE,

1se331/admin#password
Fnter old password: |§

ise331/admin#password
Enter old password:
Enter new password:

R A SN EES  BAFBENEERE, Confirm new password:
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C220-WZP27110UYA
Cisco Integrated Management Controller

S ER2 BB aunch KVM Console.


https://software.cisco.com/download/home/283801620/type/283802505/release/3.3.0
https://software.cisco.com/download/home/283801620/type/283802505/release/3.3.0
https://software.cisco.com/download/home/283801620/type/283802505/release/3.3.0
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https://www.cisco.com/c/en/us/td/docs/security/ise/sns3700hig/sns_3700_hardware_install_guide/m_installingserver.html#Cisco_Task_in_List_GUI.dita_dc47f5a6-8003-4d97-9b09-6d66e6ff0f33

%= il Cisco Integrated Management Controller R v admin@10 127 83 162 - C220-WZP2T110UYA  X¥

[ sis [ Summary sfresh | Host Pow . ml| | ciMC Reboot | Locater LED | @ @
Server Properties Cisco Integrated Management Controller (Cisco IMC) Infor
Product Name: SNS-3715-K9 Hostname: C220-WZP27110UYA

Serial Number: IP Address: 10127 197 246

PID: MAC Address: EC F4.0C4866:2C
UuID: 720B048D-0FB1-4945-9196-0890C0332A18 Firmware Version: 4 '{:I:"QJ
BIOS Version: C220M6.4 2 3c 0_ISE Current Time (UTC):  Sat Feb 15 10:30:00 2025
Description: Local Time: Sat Feb 15 10:30:00 2025 UTC +0000 {Local)
Asset Tag: | Unknown Timezone: UTC

S ER3 BEEBIZE virtua Media = I IEIBVKVME BRFIVDVD,

sliatlis KVMConsole  SNS3715K9  WZP2Z7110UYA & admin 0.
Console
File
View
Macros

Tools

Virtual Media 3 Create Image

'

VKVM-Mapped vHDD

HRAREISOBRYIZ—T "HIREEEER, -



Map Virtual Media - CD/DVD

S ER5.18Macros > Static Macros >Ctrl-Alt-Del {2 8 F ISORR G B B Cisco SNS-36XXE Cisco SNS-37XX&E

o

s yKVM KVMConsole  SNS3715K3  WZP27110UYA

B3 console
& File
View
» E Q, Search
Tools Manage Macros Ctrl + Alt + Delete
Power Alt + Enter

Boot Device > Alt + Escape

B} virtual Media > Alt+Fs

= chat Alt + -
Alt + Shift + Escape

Alt + Print Screen

B EERETEHERRE.

HER6 ILFORFARMEIERE, RREAS



bitps//10.127.197.246/%
el ykvM KVM Console SNS-3715K9 WZP27110UYA

Console

File

View

Macros
Tools

Power

Boot Device
Virtual Media

=/ Chat

59 PM
A% 500 &

| skt Cisco Integrated ManagementCc X [l v¥VM - 10.127.197.246

bitps//10.127.197.246
el ykvM KVM Console SNS-3715K9 WZPZ7110UYA
Console
File
View
Macros
Tools

Power

Boot Device

Virtual Media

= Chat

7:00 PM
A e s B

S ERS. AN R IBIB A ih 2R HI| 43 | R E AR A | FRiEIESystem Utilities ( #888/E543858 ) HSystem
Utilities ( &2 %1#2 %8 ) (Serial Console):




Al yeym KVMConsole  SNS3715K9  WZP27110U¥A
5] Console
=i File

T View

&g Macros > Sustem U1 1LIDIeS ERsubor il o)

£  Tools
O  Power

"~ Boot Device
& Virtual Media

) chat

isco ISE Installation (Keyboard/Monitor)

1sco ISE Installation (Serfial Console)
oystem Utilities (Reyboard/Monitor)
system Utilities (Serial Console)

3 BR11.7£System Utilities iZFERecover Administrator Password Option 1,

WV Comsele  ENSITIENS WIPZTTIIOUVA




Availlable System Utilities:

[l1] Recover AdMministrator Password

[Z] Uirtual Machine Resource Check
[3] Perform System Erase
[q] Quit and reload

Enter option [1 - 31 q to Eluit:

KM Comole SNSITISHT WIP2TTI0UMA

#BAEERT, ABE—TEnter
TROWBETRENTFNEAERR , Ak KenterEEETR., ZFIEET
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Admin Password Recowvery

This utility will reset the password for the specified ADE-0S administrator
At most the first five administrators will be listed. To abort without
saving changes, enter [g] to Quit and return to utilities mMenu

AdmMin Usernames

I [1] admin l

Enter choice [1] or q to Quit :

FRI0.BAFRR , RRBAYURBEFEL

s YEVM

Console

& Tocls

' Powsr

Boot Dence

B virtual Media

Chat




e VEVM VM C SHSATISHY  WIZPITTIONNA

EZBEEC TN

This utility will reset the ird for the specified ADE-0S administrator.
At t the first fi administrators will be listed. To abort without
saving changes, enter [g] to Quit and return to utilities Menu

Admin Usernames
[1] admin

Enter choice [1]1 or q to Quit
ord:

Uerify password:

ordered data mode. Opts:

FBR11.EHRBCLI, FFEEQuitFreload , # Aoption g



Availlable System Utilities:

L1] Recover AdmMministrator Password
[2] Virtual Machine Resource Check
[3] Perform System Erase

Uuit and reload

Enter option [1

£ F A A B USBE 1T BB IR 18

iR Al : BU A5/ 8HUSBEERIZR. F2RELR USBEIE AL E BRISE,

SR 8 E BT 5B/ Cisco Secure ISE ISOMGHY AT 51 B USBER E) 251F A USBIE,

S EB2 BRICisco SNS-36XXH,Cisco SNS-37XXEEER.

HER3. L F6 1 ABIOSIEE,


https://www.cisco.com/c/en/us/td/docs/security/ise/3-3/install_guide/b_ise_installationGuide33/b_ise_InstallationGuide33_chapter_4.html
https://www.cisco.com/c/en/us/td/docs/security/ise/3-3/install_guide/b_ise_installationGuide33/b_ise_InstallationGuide33_chapter_4.html
https://www.cisco.com/c/en/us/td/docs/security/ise/3-3/install_guide/b_ise_installationGuide33/b_ise_InstallationGuide33_chapter_4.html
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alvals,
cisco SNS-3715K9 WZP27110UYA

Console

File

View

Macros
Tools

Power

Boot Device
Virtual Media

Chat

6:59 PM
A% 500 5

';'l',';'o" vKVM KVM Console SNS-3715K9 WZP27110UYA
Console
File

View

Macros

Tools

Power

Boot Device

Virtual Media

Chat
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Al yeym KVMConsole  SNS3715K9  WZP27110U¥A
5] Console
=i File

T View

&g Macros > Sustem U1 1LIDIeS ERsubor il o)

£  Tools
O  Power

"~ Boot Device
& Virtual Media

) chat

isco ISE Installation (Keyboard/Monitor)
Cisco ISE Installation (Serkal Console)
oystem Utilities (Reyboard/Monitor)
system Utilities (Serial Console)

S Bo. MRREARER FiZiERecover Administrator Password Option 1,
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Availlable System Utilities:

[1] Recover Administrator Password

[Z] Virtual Machine Resource Check
[3] Perform System Erase
[q] Quit and reload

Enter option [1 - 31 q to Quit:

BEEE1 (MEEEERT) .
TRTWBETRENZENEAERR , Rk HenterEEETR.
RFIEET




W Cormede ENS-ITIEHT WIFITI0UYA

Admin Password Recowvery

This utility will reset the password for the specified ADE-0S administrator
At most the first five administrators will be listed. To abort without
saving changes, enter [g] to Quit and return to utilities mMenu

AdmMin Usernames

I [1] admin l

Enter choice [1] or q to Quit :

SEREBAFNBRIBLRA "y, UREER.

s YEVM

Console

& Tocls

' Powsr

Boot Dence

B virtual Media

Chat
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This utility will reset the ird for the specified ADE-0S administrator.
At t the first fi administrators will be listed. To abort without
saving changes, enter [g] to Quit and return to utilities Menu

Admin Usernames
[1] admin

Enter choice [1]1 or q to Quit
ord:

Uerify password:

ordered data mode. Opts:

SO EFRBCL, FREBquittEFHHEA , A%RE Aoption qo



Available System Utilities:

[1] Recover Administrator Password
[Z] Virtual Machine Resource Check

[3] Perform System Erase
[q] Quit and reload

Enter option [1 - 31 q to l]ui’r:E

|SE & HR A 85 A BB IS IR 18

FIEE , VMWareZ2FERAMIRE |, B LUBBVspherefiBEI1TATHER -
TR ISORR LEIERMBENRTR,

S ER2 BARAISEE R EIR,

¢ & ise2025-3-3

o]

SERINBFEPREBEEMES | 2 — T Actions >Edit Settingso



& ise2025-3-3

Summary Monitor

Compute Policies

VIEW ALL POLICIES

Giliec<t OS

— | B

Configure Permissions (1 Actions - ise2025-3-3
Power

Guest OS
Snapshots

2 Open Remote Console

(3, Migrate...

Clone
Fault Tolerance
VM Policies

Template

Compatibility

Export System Logs...

@ Edit Settings...

»shots



Edit Settings = ise2025-3-3

Virtual Hardware VM Options

> CPU
» Memory
> Hard disk 1

5> SCSI controller O

s Network adapter 1

5 CD/DVD drive 1

> Video card
VMCI device

> Other

300 GB v

LSI Logic Parallel
BGL14-GEN-VLAN-97 ~

Datastore I1SO File v

Specify custom settings v

Additicnal Hardware

Connected

5‘/':5%4. N Virtua Hardware > CD/DVD, check for ISE 3.3 1SO file "Cisco-1 SE-3.3.0.430.SPA .x86_64.is0" and click OK.



Select File

Datastores Contents Information
=] BOLI4-GEN-13Y

= BGL14-GEN-TMPL
& BGL14-GEN-147

CEPNM-APL-FED-6.0.0.0-113-1-K9.is0 Mame: Cisco-
ISE-3.3.0.430.5PA.x86_64.iso
Size:12.57 GB

& Check_Point_R81.10.is0 Modified:09/15/2024, 1:35.09 PM
&= BGL14-GEN-TMPL-01 _ Encrypted: No

L@

E
& BGL14-GEN-TMPL-02 Check_Point_R81.20_T631_ScalablePlatform.
S BGL14-GEN-165 [& cipc old image.iso

S0 [f;geere

& SERIAL [® Cisco-ISE-3.3.0.430.5PA.x86_64.i50 o
i
B BGL14-GEN-169 [& Cisco-ISE-

= BGL14-GEN-170 PIC-3.4.0.608a.5PA.x86_64.is0

[ Check_Point_R80.10_T479_Gaia.iso

B BGL14-GEN-171 [& cisco-webex-meetings-
@ BGL14-GEN-172 server-3.0.1.3119.C.iso

(]

= BGL14-GEN-173 (&
@ BGL14-GEN-174 Cisco_Firepower_Mgmt_Center-6.4.0-113-

Restore.iso

b
b
>
>
>
>
b4
b

B BGL14-GEN-175

]
"

File Type: [ ISO Image (".iso) v

S ER5.7ECD/DVDERE T , BUA connect At PowerOn and dlick OK.



Edit Settings = ise2025-3-3 %

Virtual Hardware VM Options

ADD NEW DEVICE ¥

> CPU L @
> Memory v GB v
> Hard disk 1 300 GB v
5> SCSI controller O LSl Logic Parallel
> Network adapter 1 BGL14-GEN-VLAN-97 v Connected
~ CD/DVD drive 1* Datastore ISO File v ¥ Connected
Status E*Cormect At Power On
CD/DVD Media [ISO] Cisco-ISE-3.3.0.430.SPA.: | BROWSE...
Device Mode Emulate CD-ROM v
Virtual Device Node IDEQ v IDE(O:0) CD/DVD drive 1 v
> Video card Specify custom settings v
VMCI device
> Other Additional Hardware

$B86.7EenabledvMm Options > Boot options, ForceBIOSSetup I~ , SRR3R — T ok.



Edit Settings = ise2025-3-3 %

Virtual Hardware VM Options

> General Options VM Name: ise2025-3-3

VMware Remote Console Options
>

Lock the guest operating system when the last remote user disconnects
> Encryption Expand for encryption settings
> Power management Expand for power management settings
> VMware Tools Expand for VMware Tools settings
!E&Boot Options Expand for boot options
» Advanced Expand for advanced settings
> Fibre Channel NPIV Expand for Fibre Channel NPIV settings




Edit Settings = ise2025-3-3

Virtual Hardware VM Options

> General Options

VMware Remote Console Options

» Encryption
> Power management

> VMware Tools

VM MName: ise2025-3-3

k the guest operating system when the last r

Expand for encryption settings

Expand for power management settings

Expand for VMware Tools settings

v Boot Options

Firmware

Boot Delay

Force BIOS setup

Failed Boot Recovery

» Advanced

> Fibre Channel NPIV

BIOS (recommended) v

When powering on or resetting, delay boot order by
0 i milliseconds
[;I During the next boot, force entry into the BIOS setup screen

[ 1f the VM fails to find boot device, automatically retry after
10 seconds

Expand for advanced settings

Expand for Fibre Channel NPIV settings

HER7 BRUSE VML EE VM2 FIERIBIOSIR Ro



& ise2025-3-3 2 @ : ACTIONS

Summary Monitor Configure Permissions Datastores Networks Snapshots

Power Status @_J Powered On
Guest OS A Red Hat Enterprise Linux 8 (64-bit)
VMware Tools Running, version:12325 (Guest Managed) @
DNS Name (1) ise330
IP Addresses (7) 10.127.197.174

_ 169.254.2 1

| LAUNCH REMOTE CONSOLE l @ AND 5 MORE

LAUNCH WEB CONSOLE Encryption Not encrypted

is02025-3-3 Enforce US Keyboard Layoul Send Crl+Alt+Delete

Hain Advanced

Iten Specific Help

CD-ROM Drive
Removable Devices Keys used to view or
Network boot from Intel E1000 configure devices:
<Enter> expands or
collapses devices with
a+or -

<Cirl+Enter> expands
all

<+> and <-> moves the
device up or doun.

<n> May move removable
device between Hard
Disk or Removable Disk
<d> Remove a device
that is not installed.

Help Select Iten Change Values Setup Defaults
Exit Select Menu Select » Sub-Menu Save and Exit

S B8 E MR EN B cD-RoM Drivedf i H B R E — B E,



PhoenixBI0S Setup Utilit

Hain Advanced security

Item Specific Help

+Removable Devices
+Hard Drive Keys used to view or
Network boot from Intel E1000 conf igure devices:
{Enter> expands or
collapses devices with
a+aor -

{Ctrl+Enter> expands
all

<+» and <-> moves the
device up or down.

<n> Hay move removable
device between Hard
Disk or Removable Disk
{d> Remove a device
that is not installed.

Change Ualues Setup Defaults
Select » Sub-MHenu Save and Exit

*/Fg'%g.gf_-FEntero E%Ei‘\ﬁlﬁ %

BIRIFFE | system Utilities (Keyboard/Monitor)Selectoption 3.

Enforce US Keyboard Layout §| View Fullscreen § Send Cirl+AltsDele

Helcome to the Cisco Idemtity Services Engine Installer
Cisco ISE Version: 3.3.8.438

Automatic installation starts in 158 seconds.
Available boot options:

[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Reyboard/Monitor)

[4] System Utilities (Serial Console)

[5] Hard Disk

Enter boot option and press <Enter>.

boot:




ise2025-3-3 Enforce US Keyboard Layout

Helcome to the Cisco Identity Services Engine Installer
Cisco ISE Version: 3.3.8.438

Automatic installation starts in 158 seconds.
Available boot options:

[1] Cisco ISE Installation (Keyboard-/Monitor)
[2] Cisco ISE Installation (Serkial Console)
[[3] System Utilities (Reyboard/Monitor) |

[4] System Utilities (Serial Console)

[5]1 Hard Disk

Enter boot option and press <Enter>.

boot: 3_

5 B810. 1] F system Utilities, chose the BF IR E BB E %G, BE1IRUEISEEE LEENEEERFNG

o

ise2025-3-3

Available System Utilities:

[1] Recover Administrator Password
[2] Uirtual Machine Resource Check
[3] Perform System Erase

[gq] Quit and reload

Enter option [1 - 31 q to Quit:

S ER11.8 AOption 1AEHREA BEadminfI BB & AFFH. WAYURTFRIEE,




Is02025-3-3 Enforce US Keyboard Layout | View Fullscreen J Send Gt

Admin Password Recovery

This utility will reset the password for the specified ADE-0S administrator.
At most the first five administrators will be listed. To abort without
saving changes, enter [gl] to Quit and return to utilities mMenu

AdmMin Usernames

[1]1 admin

Enter choice [1] or q to Quit

This utility will reset the password for the specified ADE-05 administrator.
At most the first five administrators will be listed. To abort without
saving changes, enter [gl] to Quit and return to utilities menu

AdmMin Usernames
[1] admin
Enter choice [1] or q to Quit

Password:
Verify password:

d data mode. Opts:

[
[
[
(

null)

EXRBRRIRE

S BR12.8 A qLLUR H H system UtilitiesHl



ise2025-3-3

Available System Utilities:

[1] Recover AdmMministrator Password
[2] Virtual Machine Resource Check
[3] Perform System Erase

[g] Quit and reload
Enter option [1 - 31 q to ﬂuif:[:::]

S ER12 #&CD/DVDEREE i Abefore , I 7£ B AF 22 B jE 4R

Edit Settings = ise2025-3-3 X
Virtual Hardware VM Options

ADD MEW DEVICE v~

> CPU 2 v @

> Memory w GB o

» Hard disk 1 300 GB v

» SCSl controller O LSl Logic Parallel

» Network adapter 1 BGL14-GEN-VLAN-97 Connected

v CD/DVD drive 1* v B Connected
Status
CD/DVD Media To connect, power on the VM and select the media from the VM

Hardware panel on Summary tab

Device Mode Emulate CD-ROM v

Virtual Device Node DEO v DE(0:0) CD/DVD drive 1 v
> Video card Specify custom settings v

VMCI device
> Other Additional Hardware

Q&



BARS LLEMRE
BRI EERABRMAIRNEESX G, RUHFRNERAEEANECH

[=]
SNy

EEERLENE.
EMERBLEMEEE, DRNUEBEMBONEER, Cisco Systems, Inc. HHELEBILE

BEHSIEE, TES—RERRAERXXNG (REHES) .



